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iv

The NCEA Level 3 Mathematics and Statistics Achievement 
Standards for Year 13
There are 15 Achievement Standards for the realigned NCEA Level 3 assessment in 2013. These 
comprise seven Achievement Standards covering statistics, and eight Achievement Standards 
covering mathematics – including calculus, algebra, trigonometry and geometry. All 15 Achievement 
Standards relate to Level 8 of the New Zealand Mathematics and Statistics Curriculum.

Sigma Statistics addresses all seven NCEA Level 3 Statistics Achievement Standards (AS 3.8 to AS 
3.14 inclusive).

Delta Mathematics provides full coverage of the eight NCEA Level 3 Mathematics Achievement 
Standards (AS 3.1 to AS 3.7 inclusive, and AS 3.15).

Sigma Statistics
Sigma Statistics is a brand-new, statistics-focussed textbook following in the tradition of Sigma 
Mathematics. The content of Sigma Statistics is closely aligned with, and responds to, recent 
developments in New Zealand statistics education.

The sections on Achievements Standards 3.10, 3.11 and 3.12 provide ground-breaking and 
balanced coverage of the ultimate stages of the statistics enquiry cycle approach The emphasis is on 
statistical interpretation, analysis and inference, rather than on old-style statistical calculation. This 
part of the freshly upgraded textbook features statistical resampling methods, such as bootstrapping 
for statistical inference, and randomisation to assess the significance of statistical evidence, including 
the results of statistical experiments and observational studies.

The sections on Achievements Standards 3.8 to 3.11 are closely integrated with the pioneering 
work on statistical inference developed by Professor Chris Wild and his team at the University of 
Auckland. The textbook provides instructions and worked examples for using the new iNZight 
data analysis and VIT (Visual Inference Tools) software. Alternative methods of analysis include 
spreadsheets, apps and coverage for CAS calculators.

Throughout the textbook, data are provided from a large number of contemporary New Zealand 
sources. All data sets have been reviewed to ensure they are up-to-date and, where possible, set in 
a New Zealand context. References to a variety of technological tools ensure that students are well 
prepared to analyse tables, graphs and statistics and make inferences, reaching conclusions that can 
be supported by the data.

The new section on statistical experiments features wide-ranging coverage of experimental design 
(treatment and response variables, allocation of treatments, factorial design, controls, blocking, 
confounding and more), as well as new tools for interpretation, such as main effects plots. All of 
these concepts are new in the Year 13 classroom. There is also a comprehensive selection of statistical 
reports, which give students the opportunity to practise critiquing causal-relationship claims and 
interpreting margins of error.

The parts of Year 13 Statistics that have evolved from the current NCEA Level 3 Statistics and 
Modelling Achievement Standards have been extensively upgraded. The content has been carefully 
revised in line with best teaching practice, and expanded to respond to changes in the curriculum 
and assessment. Among the mathematical changes are:
• new material on probability distributions, focussing on the mean and standard deviation as 

properties of a distribution
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3.8

3.9

3.10

3.11

3.12

3.13

3.14

• coverage of deterministic versus probabilistic concepts, or true versus experimental versus 
theoretical probability (Achievement Standard 3.13)

• new material on risk and relative risk that strengthens the probability section in Achievement 
Standard 3.13.

Delta Mathematics
Delta Mathematics is the final textbook in the award-winning Pearson secondary mathematics series 
for New Zealand schools. It contains the NCEA Level 3 Mathematics Achievement Standards 3.1 to 
3.7 inclusive, and 3.15.

Delta Mathematics textbook features coverage of Achievement Standard 3.4, ‘Critical path analysis’ 
– a first for New Zealand schools – and builds on the networks topic introduced in Theta Dimensions.

Delta Mathematics

3.1 Geometry of conic sections 

3.2 Linear programming methods
3.3 Trigonometric methods

3.4 Critical path analysis
3.5 Complex numbers
3.6 Differentiation methods
3.7 Integration methods
3.15 Systems of simultaneous equations
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vi

The Sigma package
The Sigma package features four complementary units that, when used together, provide a complete 
solution for the Year 13 Statistics student and teacher. The package comprises Sigma Statistics 
textbook (both print and e-book versions), Sigma Statistics Workbook and Sigma Statistics Teaching 
Resource. In addition, there is additional support material supplied at the www.mathematics.co.nz 
website.
• Sigma Statistics textbook – the traditional paper textbook for student use in the classroom, 

featuring theory notes and explanations, worked examples, comprehensive exercises that are 
graded in difficulty, opportunities to practise using different types of technology – and much 
more.

• Sigma Statistics Workbook has a fresh, new, double-page-spread design, and provides back-up 
exercises for students to practise statistics outside the classroom. The accompanying Sigma 
Statistics student CD includes all the data sets needed for the statistical-analysis activities in both 
the textbook and the workbook.

• Sigma Statistics Teaching Resource – every page in the textbook is provided electronically, in two 
views – one for classroom use on an electronic whiteboard or for datashow display, and the 
other in the form of a guide for teachers, with author comments and advice. The Sigma Statistics 
Teaching Resource is a veritable treasure-trove of practice NCEA assessments and apps specially 
commissioned by Pearson for Year 13 Statistics, solutions to harder questions, exercises at 
Scholarship level, spreadsheets, Microsoft PowerPoint demonstrations of worked examples and 
web links.

• Sigma Statistics e-book is the textbook in electronic format, and contains dynamic links to 
spreadsheets, animations, answers and relevant websites. The e-book provides schools the 
flexibility and support to devise their own statistics courses.

About the authors

Claire Laverty has taught mathematics and statistics at several schools in Dunedin. She has 
participated in writing workshops and been closely involved in developing support material, 
including assessment resources, for the new mathematics curriculum. Claire Laverty is the 
author of the popular Practice NCEA Assessments provided as part of the Gamma Mathematics 
Teaching Resource and the Theta Mathematics Teaching Resource. An enthusiastic and expert teacher, 
Claire brings fresh new ideas to the writing team.

Author David Barton needs no introduction to a generation of New Zealand mathematics 
students and teachers. He has written a full six-book, award-winning series for secondary-school 
mathematics, and his material has also been published in Australia, South Africa, Fiji and Abu 
Dhabi. David Barton was educated at Wellington College, and has taught at Wellington College 
and Rangitoto College in Auckland.
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Foreword to students and teachers
Welcome to Year 13 and a new mathematical pathway – entering the world of statistical inference 
and modelling probability.

When initiating the update for Sigma Mathematics, we recognised that statistics makes up an 
increasing proportion of the Year 13 curriculum and decided to reflect that change by naming this 
textbook Sigma Statistics. The textbook has been completely updated and reorganised to reflect the 
change in emphasis in the New Zealand Curriculum, and to provide you with full coverage of the 
NCEA Level 3 Statistics Achievement Standards (the other eight Level 3 Achievement Standards are 
covered in Delta Mathematics).

The seven Achievement Standards are presented in separate colour-coded sections so that you 
know exactly which topics fit where!

The liberal, and functional, use of colour throughout makes the textbook appealing and easy to use.
All the topics are accompanied by a large number of well-balanced questions, graded in difficulty, 

to reinforce students’ understanding and build solid foundations for future learning. Throughout 
the book, application-type questions and situations – with as many as possible in a New Zealand 
context – are provided to make the underlying mathematics more interesting and relevant. Many 
investigations, spreadsheet activities and puzzles have been added. Try doing these – you will be 
surprised at how often intriguing mathematics is found in unexpected and unfamiliar situations.

Advancing technology has dramatically changed the possible approaches to teaching and learning 
statistics, placing more emphasis on understanding and interpretation, and less on computation.

Throughout Sigma Statistics, there are references to appropriate technology. Computer and calculator 
software has revolutionised the learning of statistics and probability models, thereby enabling students 
to focus on the interpretation of data and modelling situations rather than on laborious calculation. The 
challenge for students and teachers is to become competent users of this new technology – to be able to 
select the appropriate tools and functions, and to judge whether the output is reasonable.

Sigma Statistics includes a full range of instructions and worked examples that support 
technology, including the following.
• Spreadsheets – the spreadsheet program referred to is Microsoft Excel 2010 although the 

instructions are largely generic and also apply to other spreadsheet software.

• The new iNZight data analysis and VIT (Visual Inference Tools) software –developed by Professor 
Chris Wild and his team at the University of Auckland to support the implementation of the 
statistical enquiry cycle approach.

• CAS (or Computer Algebra Systems) calculators – the two referred to are the Casio ClassPad 
300 and the TI-nspire. Brief, easy-to-follow instructions are provided in the textbook, and more 

Sigma Statistics

3.8 Time series

3.9 Bivariate measurement data
3.10 Statistical inference – making comparisons
3.11 Statistical experiments
3.12 Statistically based reports
3.13 Probability concepts
3.14 Probability distributions
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ixForeword to students, parents and teachers

STARTER

INVESTIGATION

PUZZLE

TEACHER

TIP

TECHNOLOGY

DATA SET INTERNET CAS CALCULATOR

comprehensive instructions are included in a special section of the Sigma 
Statistics Teaching Resource. Screenshots are displayed alongside worked 
examples to show the input and output.

• Other types of useful technology – some software packages can draw better-
looking mathematical graphs than either a spreadsheet or a CAS calculator. 
Some sections of the textbook include references to apps commissioned 
specially for the Sigma package.
Because statistics education is in a state of transition, the familiar tables of 

probability distributions (normal, binomial, Poisson) have been included for 
students who do not have access to appropriate technology in their classroom.

Full and comprehensive answers are provided. For most questions involving 
numerical working, answers are correct to four significant figures so that students 
can check whether their calculations are accurate. However, in some cases, answers 
have been rounded appropriately to fit the context of the question. When technology 
is being used with equation-solving or probability distributions, answers have 
often been given to six-figure accuracy – not because this is appropriate in real-life 
situations but to allow students to check that their inputs are correct.

Advice to students

You will probably use this book mainly in the classroom. However, you need to 
study and do extra activities in your own time to do as well as possible. Sigma 
Statistics Workbook is ideal for this purpose. It provides extra coverage of the 
curriculum, and revision for the course, with plenty of NCEA-style questions. 
The workbook is closely referenced to this textbook, making it really easy to 
match homework and revision with what you are doing in class. Because the 
workbook is a ‘write-on’ publication, you can add your own notes, highlight 
important points, colour-code places where you made mistakes for future 
reference or add hints from your teacher. Sigma Statistics Workbook also features a 
student CD, which includes key worked examples, all the spreadsheets referred 
to in this textbook together with suggested answers to spreadsheet activities, 
and links to internet websites. Visit the companion website for the series, www.
mathematics.co.nz , to see up-to-date links for the content of Sigma Statistics.

Statistics will lie behind much of your career and journey through life. With 
a broad mathematics education and a positive attitude you should do well. We 
hope students and teachers enjoy their journey through the statistics course, 
and trust they find Sigma Statistics a reliable, helpful and useful companion.

Best wishes for an enjoyable, challenging and successful year.
Alea jacta est.

David Barton
Claire Laverty
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3.8 Time series16

Excel 2010

2 Click the Insert menu bar, select the Scatter option, and then the Chart type that shows 
points connected by straight lines.

 
3 Select the chart by clicking on it. In the Chart Tools menu bar, click the Layout tab, and then 

you can give the graph a title, format the axes, etc.

 

¸ Move the chart to a suitable position alongside the data – do this by clicking somewhere 
inside the chart, then holding the mouse key down and dragging.

¸ Alter the height and width of the graph to improve its appearance. Do this by clicking 
on the chart – you will notice that eight small sets of black dots appear, at each of the 
four corners and at the midpoint of each side. Place the cursor on one of these sets until 
the cursor changes to a double-arrow shape, and then click and drag.

¸ Decide on a suitable size for the labels and headings. Choose this by clicking on the 
chart title, label or axis, and then, in the Home menu bar, select the Font Size box on the 
ribbon.
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2

3.8 Time series18

1 The iNZight and VIT application will usually install in its own directory. Navigate to this 
directory and double-click the file with START in the name. Doing this opens an operating 
environment called ‘R’.

2 Click the Run iNZight button. The iNZight software is now ready to accept your data.
3 Click the Data IN/OUT tab, and then the Import Data option.

4 The File Browser opens. Use the ‘browse’ button to navigate to the spreadsheet 
that contains the data you want to use (in this example, the spreadsheet is  
Reported offences (NZ) 1990 to 2010.xlsx). When the spreadsheet name appears 
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2 Time-series analysis

2

19

in the Local file window, confirm your choice by 
clicking ‘OK’.

 

5 The data are then imported into iNZight (displayed in 
a pale-orange highlighted block), together with row 
names (or headers).

6 To start working with the data, drag the row names 
down to the variable spaces. In this example, drag 
Calendar.year down to the ‘Drop name here’ location 
alongside Variable 1, and then drag Reported.offences 
down to the ‘Drop name here’ location alongside 
Variable 2. The iNZight software automatically 
produces a graph.
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7 Sampling variability

7

147

7 Sampling variability
Mathematics and Statistics in the New Zealand Curriculum

Statistics and Probability – Statistical investigation
Level 8
•	 S8-1	Carry	out	investigations	of	phenomena,	using	the	statistical	enquiry	cycle:

–	 using	existing	data	sets
–	 seeking	explanations
–	 using	informed	contextual	knowledge,	exploratory	data	analysis	and	statistical	inference
–	 communicating	findings	and	evaluating	all	stages	of	the	cycle

•	 S8-2	Make	inferences:
–	 determining	estimates	and	confidence	intervals	for	means	and	differences,	recognising	the	

relevance	of	the	Central	Limit	Theorem
–	 using	methods,	such	as	resampling	or	randomisation,	to	assess	the	strength	of	evidence

Achievement Standard

Mathematics	and	Statistics	3.10	–	Use	statistical	methods	to	make	a	comparison

Parameters and statistics
When we sample from a population, we may use a value (such as the sample mean) to estimate the 
corresponding value back in the population. The population values we are estimating are called 
parameters, and the corresponding sample values are called statistics.

The table below illustrates some of the terminology and symbols used.

Population Sample

mean, μ sample mean, x

standard deviation, σ sample standard deviation, s

‘parameters’ ‘statistics’

Sampling variability refers to the tendency of a sample statistic to differ, 
depending on which sample we get. We may choose to use a sample 
statistic as an estimate for a population value (or parameter) but we 
cannot know how close an estimate it is. There is a level of uncertainty 
about the accuracy of such an estimate.

Sampling error is the difference between an estimate (e.g. sample 
mean) and a parameter (e.g. population mean). Sometimes, we can 
calculate probabilities for the size that the sampling error may take.

We assume that the statistics have been obtained from 
taking an unbiased, representative sample.

TEACHER
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7

3.10 Statistical inference – making comparisons152

5 Choose whether you want to carry out the sample 
bootstrapping for the mean or the median. The screenshot 
shows the median selected, with 20 as the number of 
resampling repetitions. To start the resampling process, 
click the first Go button. Then, to view the Bootstrap 
distribution, click the second Go button.

6 The results are displayed in a separate ‘R’ window. The 
screenshot below shows the results of  
20 resamples (all of size 15) from the first, original, sample.
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7 Sampling variability

7

153

The top diagram (headed Sample) shows a dot plot and a box plot for the 15 values in the original 
sample. The median is 30.

The middle diagram shows the most recent resample. In this case (but not always), the median 
of the resample was 29, and the box part of the box plot (outlined in black) extends from 26 to 34, 
showing the lower quartile and the upper quartile of the most recent resample. The faded blue and 
pink lines show a ‘memory’ for previous positions of the median and box, respectively.

The bottom diagram (headed Bootstrap distribution) shows all 20 medians for the 20 resamples. 
These medians have varied from 27 to 35.

Based on this process only, the bootstrap distribution of medians from this sample is telling us 
that the median back in the population is very likely to lie between 27 and 35.

We could improve this estimate by running a larger number of resamples. The iNZight software 
can do a maximum of 1000 resamples.

TIP In iNZight, choose the 1 repetition option and ‘Record my choices’ to see how the sampling 
with replacement works and how the first resample is gradually built up.

Bootstrapping in Excel 2010

The same data are used here as for the iNZight example above.
1 Enter or paste the values of your sample into an Excel 2010 spreadsheet. It does not 

matter if these are in a row, a column or across several rows as in this example.
2 Highlight the block of sample values.
3 Right click and then select the ‘Define Name …’ option. 

TECH
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7

3.10 Statistical inference – making comparisons154

4 Type ‘Sample’ in the 
box beside ‘Name’. 
This gives the name 
‘Sample’ to the block 
of original sample 
data from which you 
will be resampling. 

5 Choose where you want your bootstrap resamples to go (e.g. starting at cell A6). In this cell, enter 
the formula =INDEX(Sample,ROWS(Sample)*RAND()+1,COLUMNS(Sample)*RAND()+1). This 
will randomly sample values (with replacement) from your original sample.

Fill this formula across until you have a sample the same size as your original sample. (Having 
your resamples in rows rather than columns makes them easier to count!)

The screenshot shows the formula in cell A6 and the results of the first resample in row 6.

6 Highlight your resample and fill down to create the number of resamples you desire.
7 You can then create 

columns beside the 
resamples to calculate 
their statistics, e.g. 
=AVERAGE(cell range) 
for the mean, and 
=MEDIAN(cell range) 
for the median.

The screenshot shows the 
bootstrapping results of 
500 resamples, together 
with a bar graph showing 
the distribution of the 500 
bootstrap medians.
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9 Types of experiment 199

9

STARTER

For each of these six scenarios, discuss whether or not the described process is an 
experiment. Make sure you can give a reason for your decision.
1  Adrian is curious about whether longer carrots are wider at the top. He pulls 

20 carrots out of the ground and records their diameters at the top and also their lengths.
2  A toddler notices that her legs get wet when she stamps in a puddle. She stamps her 

foot harder and harder to see if she can splash more of her clothing.
3  Tamara wishes to discover whether red food-colouring has an effect on behaviour 

when not combined with sugar. At a birthday party, she puts the children in two 
rooms. In one room, the children had plain sausage rolls and, in the other room, the 
children had sausage rolls coloured with red food-colouring. Tamara notes which 
children had which food, and then observes their behaviour.

4  Ngaire believes there may be a relationship between a person’s height and his or her 
basketball ability. During a P.E. class, she measures the height of each person and then 
records the proportion of their shots at goal that are successful.

5  Hemi and one of his friends have been arguing over which type of fish bait is the best 
to use. They bait the hooks of a long-line using four different bait types. When the 
line is retrieved, they record which hooks had caught fish.

6  Amanda, Paul and Leslie all have overweight cats. They decided to each try a 
different brand of diet cat-food and record the cats’ weights each week.

Some key concepts for this topic

Concept/Term Description Comment

Factor An input variable Factors may be set at different levels. For example, if 
temperature is a factor in an experiment, trials may 
be run at 20 °C, 30 °C, etc. The heat setting chosen 
would be referred to as a ‘factor level’.

Treatment The combination of input variables 
applied in any given run of an 
experiment

A treatment description should specify what levels 
each contributing factor has been set at. For example, 
if running an experiment on seed germination, 
one treatment may be ‘20 mL water per day, full 
sunlight’ and another may be ‘30 mL water per day, 
no sunlight’.

Randomisation Assigning which treatment a 
subject is given and/or which 
order the treatments are applied is 
determined at random.

Randomisation is important because when the 
results are analysed, and we decide whether or 
not they are explained by random variation, the 
only alternative explanation is the treatment effect. 
Randomisation also avoids any pre-conceived ideas 
that the researcher may have.

Nuisance 
variable

A variable not under investigation 
that affects the results of an 
experiment

For example, if you investigate the effect of three 
different fertilisers on plant growth, it may be that 
one of your plots has better sun exposure than 
others, creating a false impression of the effectiveness 
of the fertiliser used.

(continued)
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9 Types of experiment 209

9

You may recall from junior statistics courses that the probability of an event may be estimated 
by running many trials of an experiment. The relative frequency of the desired outcome is the 
estimate of the probability.

Randomisation is similar – to find out how likely it is that a difference has occurred at random, 
we randomly assign the experiment outcomes to the groups many times. If only a tiny proportion 
of these random assignments have differences as large as the one we observed, it is likely that the 
difference is not the result of random occurrence.

Numbers of cavities in individual subjects 
aged over 2 years

Toothpaste A Toothpaste B

0 1

1 3

0 2

0 1

0 4

1 2

0 2

0 2

2 1

0 0

TIP Randomisation takes place after the experiment has taken place and the observed results 
for each group have been obtained. We randomly allocate the results to different groups a 
large number of times, and ask, ‘How likely is it that we would get the observed results if 
the experiment subjects fell randomly into two groups?’

Example

First, assign the children to one of the two toothpaste groups, and then obtain their results. These 
observed results are recorded in the table.

Mean of toothpaste A = 0.4, and mean of toothpaste B = 1.8.
Difference in means = 1.4.
Now, the randomisation takes place.
To test if the difference in means for the observed results is likely to be random, we treat the 
20 candidates as a single set that can be randomly placed in either group. The effect is similar 
to shuffling a set of cards and dealing two new hands from it.

Randomisation is used to assess the significance of the results of an experiment. 

1  Perform the experiment, and record the observed results for the treated group and for the 
control group.

2  Carry out multiple random allocations of the results to two groups of the same size as the treated 
group and the control, and obtain the distribution of the difference of their means or medians.

3  Based on this distribution, decide how likely the observed result would be. Could it have 
occurred because of random variation within the set of all results, or is the observed difference 
in means or medians so extreme that we can infer that the treatment does tend to have an effect?
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9 Types of experiment 213

9

Draw a graph to show the distribution of the difference between the two medians if the  
20 children had fallen randomly into the two groups.

Type the values that the differences take from lowest to highest into column C and, in  
column D alongside, use formulae to calculate the frequency of each value. In cell D2, the  
formula is =COUNTIF(A$2:A$1001,C2).

Graphing the frequency for the differences
The following steps produce a bar graph. The bar graph is based on the vertical error bars option 
in Excel 2010.
• Highlight the block of differences and their frequencies (C2:D10, in this example).
• Select the Insert menu bar, and on the Charts menu, choose ‘Scatter’ and then the ‘Scatter 

with only Markers’ option.
• Click anywhere inside the chart to 

select it. Then click ‘Chart Tools’, 
‘Layout’, ‘Error Bars’.

• Click ‘More Error Bars Options . . .’. 
In the Vertical Error Bars menu,  
click ‘Minus’ (in the Direction menu), 
and ‘Percentage’ (and then type in 
100 (for 100%)). Click ‘Close’.

Analysis comparing the original experiment data to the randomised results
In the original experiment, the observed difference between the medians was −2. In the 1000 
randomisation simulations, only 17 of the groups had a difference this low. As −2 is in the bottom 
1.7% of the randomised differences, it is unlikely that this difference is a random occurrence. We 
therefore can infer that toothpaste A is the more effective brand.

TIP An alternative is to draw a column 
graph but that does not give a useful 
scale on the horizontal axis.
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3.12 Statistically based reports292

13

b Explain how the resolution rates are calculated.
c The numbers of these crimes appear to have fallen between 2008 and 2010. Comment on 

what other data are needed to decide whether the rate at which these crimes are being 
committed is also dropping.

5 The following table shows statistics from various European football leagues in 2011.

League Games First–last 
points gap

Average 
points

Standard 
deviation

Bundesliga (Germany) 18 22 24.72 7.66

Ligue 1 (France) 20 25 26.90 8.17

Serie A (Italy) 19 29 25.35 8.52

La Liga (Spain) 19 37 25.85 8.67

Premier League 
(England)

22 39 30.25 11.04

(Source of data: http://www.goal.com/en-gb/news/3275/bundesliga/2012/
01/27/2869687/revealed-bundesliga-is-more-competitive-than-la-liga-serie-a)

a A competitive league has many teams that might win the title, so it tends to have mostly 
well-matched teams. Less competitive leagues tend to have only one or two strong 
competitors and more teams that have little chance of winning.
i Which two measures might be the best indications of whether the leagues are 

competitive?
ii Which of those two measures is the better measure for comparing the different leagues, 

and why?
iii Which of the leagues seems to be the least competitive and why?

b Does the number of games played seem to relate to the standard deviation? Comment.

6 Read the report about collision repairs and answer the questions that follow.

Body shop estimates vary by 200%
The estimated cost of collision repairs can vary between shops by more than 200 per cent, 
according to a recent study conducted by auto body Internet-technology company, DingIT.

DingIT’s study surveyed a large number of collision repair estimates submitted by body shops  
for the same vehicle damage. The damage estimates ranged from $200 to $690. DingIT said  
26 per cent of the damage estimates it received were between $200 and $400, 57 per cent were 
between $400 and $600, and 17 per cent were more than $600.

The distribution of the study’s results show that the low- or high-cost estimates were not just 
outliers or the result of mistakes, DingIT said. Twenty-six per cent of the estimates received were 
in the $200 range, which indicates that those estimates were real rather than attempts to attract 
customers with low offers.

Factors such as part types, repair or replace decisions, estimated labor hours, rental vehicles, 
and the inclusion of supplemental parts or labor can have significant impacts on repair costs 
estimated for consumers.

(Source:	FenderBender.	(24	January	2012).	Retrieved	from	http://www.fenderbender.com/
FenderBender/January-2012/DingIT-Body-shop-estimates-vary-by-200/	(abridged))
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The butterfly effect holds that, in a complex system (such 
as global climate), every variable is linked, no matter how 
remotely, and so very small changes to initial conditions can 
snowball into large differences in a later state. The butterfly 
effect is commonly used in science fiction where, for example, 
the hero travels back in time to make a small change that 
ultimately saves the world from a future catastrophe.

True probability vs. experimental probability vs. theoretical probability
The table identifies the three types of probability and their features.

Type of probability Model Likely occurrence of future event

True probability Deterministic Usually unknown

Experimental probability
Probabilistic

Applying past results to the future

Theoretical probability Based on a model

All three types of probability are involved when considering the process of how birth gender is 
determined and the likelihood of the two different outcomes.

SCENARIO

One of the most memorable experiences for any parent is finding out the gender of their expected 
baby or newborn child. Human biology tells us that gender is determined by how X and  
Y chromosomes are mixed at the time of conception. When the egg is fertilised by sperm carrying 
an X chromosome, a female will result; fertilisation by a Y-chromosome sperm will result in a male. 
Y-chromosome sperm has higher motility and X-chromosome sperm has greater longevity.

Mathematics teachers worldwide rely on the assumption that a newborn child is equally likely 
to be a boy or a girl. Is this true? Let’s discuss this in terms of true, experimental and theoretical 
probability.

1 True probability

True probability involves an exact understanding of all the factors involved that lead to a certain 
outcome. Some of these factors may really be random in nature, but others are pre-determined 
although they are difficult to track right through to the end of the process.

The process by which gender is determined at conception is largely unknown, because many 
factors (other than X and Y chromosomes on the sperm) may be involved. Here is what we do not 
know.
•	 Is gender influenced more by the father or by the mother?
•	 Does gender depend on the age of the mother or father?
•	 Is gender related to the parents’ occupations? For example, a worker in a fertiliser-manufacturing 

plant might be more subject to chemical exposure than someone who works in an office.
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a Write the density function for X.
b Calculate P(X > 5).

6 A tow-rope is connected between two cars. 
The rope is equally likely to fray and snap at 
any point along its 12 m length.
a Calculate these probabilities:

i P(the tow-rope frays and snaps 
within 2 m of the middle)

ii P(the tow-rope frays and snaps 
within 1.5 m of one end).

b The tow-rope frays and snaps at a point 
that is within eight metres of the towing 
car. What is the probability that this 
point is nearer to the towed car than to 
the towing car?

7 On a rapid-rail network, the trains arrive at 
regular four-minute intervals. The timetable is 
so reliable that most commuters arrive when 
convenient. Suppose X is the random variable 
for the number of seconds a commuter has to 
wait on the platform.

a Give the probability density function for X.
b Evaluate these probabilities:

i P(X < 120)
ii P(X ≥ 187)
iii P(5 < X ≤ 235).

c Describe one or more limitations to this 
model.

8 One possible model for the position that a 
dart lands on a dartboard relative to the bulls-
eye at the centre is that any distance from 
the centre to the rim is equally likely. The 
diameter of a regulation dartboard is 45 cm.
a Define a rectangular distribution model 

for this distance by writing its pdf.
b Give at least three reasons why this 

choice of model is not appropriate.

The triangular distribution

A triangular distribution, in general, is defined for values of x between a and b. It has a peak at a 
point x = c somewhere between a and b.

a

Peak

c b x

f(x)

2
b − a

In the same way as other pdfs, the total area underneath f(x) between x = a and x = b is 1, and this 
property allows us to construct the equations.

The height of the triangle is h.

TIP A triangular distribution is not necessarily 
symmetric, so c is not always halfway 
between a and b.
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1 Using a CAS calculator 

Casio ClassPad 300

The command is PoissonCD and the 
input syntax is x, λ, in that order, and no 
brackets are used.

TI-nspire

The steps are:
1 Menu
2 1:Add Calculator
3 Menu
4 5:Probability
5 5:Distributions
6 I:Poisson Cdf
Note that the ‘Lower bound’ is preset 
to 0. In this case, input the values of λ 
and x (the ‘Upper Bound’) into their 
respective windows and then click ‘OK’.

2 Using a spreadsheet (e.g. Excel 2010)

The formula is =POISSON() and the input syntax is (x, λ, TRUE), in that order, 
and inside brackets. The ‘TRUE’ is required to calculate the sum of the individual 
probabilities from 0 to x.

TEACHERIn this section, answers are given to at least six decimal places. This is 
highly unrealistic in a probability context, but the results of calculations 
are presented this way so that students can check they have entered inputs 
correctly.

TECH
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1 It is reasonable to assume that the number of earthquakes that occur during a 
short time-period can be modelled by a Poisson distribution.

(Source: http://earthquake.usgs.gov/earthquakes/world/seismicity_maps/)

The frequency table gives the number of earthquakes over magnitude 7 per quarter between  
1 January 1995 and 30 September 2005. For example, there were 12 quarters over this period in  
which there were two earthquakes in that quarter.

Number of earthquakes  
per quarter

Frequency

 0  1

 1  0

 2 12

 3 10

 4  6

 5  5

 6  4

 7  3

 8  1

 9  1

10  0

Total 43

Exercise 22.03

TECH
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How do we represent the graph of the Poisson distribution? Because the Poisson distribution 
is discrete, a bar graph, where the heights of each column represent the probabilities, is the most 
appropriate representation.

Example

Draw the graph of the Poisson distribution, X, with parameter λ = 4.3.

Answer

The graph can either be drawn by hand, after calculating P(X = 0) through to about 
P(X = 12), or a statistical graph package or spreadsheet can be used.
The screenshot shows the calculations and graph produced by the interactive  
spreadsheet Poisson probability grapher.xlsx. This spreadsheet is provided on the 
Sigma Statistics student CD and with the e-book version of this textbook, as well as the 
Sigma Statistics Teaching Resource.

Alternatively, use an app like 
the Pearson Poisson Distribution 
Grapher. You can use a slider to 
adjust the values of λ to see the 
effect on the graph. The app also 
shows the position of the mean 
(given by the red line) and the 
extent of the standard deviation 
(shown by the green line). This 
app is provided with the e-book 
version of this textbook, as well 
as the Sigma Statistics Teaching 
Resource.

TECH
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